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GGSSAAKK 110011!!
Dies ist eine schrittweise Einweisung in GSAK. Jeder unterstrichene Textteil
ist ein Link zu einer Website – klicke auf den Text, um direkt dorthin zu
gelangen. Diese Einführung ist sehr ausführlich (Schritt für Schritt) und
deshalb ziemlich lang. Keine Sorge! Wenn Du ihn durchgearbeitet hast kannst

Du GSAK sofort alleine benutzen.

Bitte beachte:  dieses Handbuch ist eine Einführung in GSAK. Es sollte von Anfang bis
Ende durchgelesen werden (wenngleich nicht unbedingt auf einmal), und jedes Kapitel
baut auf das vorherige auf. Wenn Du Kapitel liest, ohne die  vorherigen gelesen zu
haben, werden Dir Grundlagen fehlen und Du wirst das Programm nicht verstehen.

Englische Bezeichnungen der Bedienelemente von GSAK werden unmittelbar danach in
[eckigen Klammern] erläutert.

Viele Merkmale von GSAK werden hier nicht behandelt – weitere Informationen erhältst
Du durch die GSAK-Hilfe (klicke im Hauptmenue “Help” und dann “Contents” an oder
drücke die F1-Taste).

GEOCACHING.COM PREMIUM MEMBERSHIP

Um GSAK vollständig ausnützen zu können, musst Du GPX (und nicht LOC)-Dateien
von Geocaching.com herunterladen. GPX-Dateien beinhalten fast alle Informationen der
Cache-Seite und ermöglichen Dir, alle diese Informationen in GSAK zu laden. LOC-
Dateien enthalten nur den Cache-Namen und die dazugehörigen Koordinaten. Obwohl
GSAK auch mit LOC-Dateien arbeitet, erhältst Du mit diesen keine detaillierten Cache-
Beschreibungen, mit denen Du die vielfältigen Vorteile von GSAK nutzen kannst.

Geocaching.com setzt eine “Premium Membership” voraus, um
GPX-Dateien laden zu können. Die Kosten für eine Premium-
Membership betragen monatlich $3.- oder jährlich $ 30,-.
Klicke auf http://www.geocaching.com/subscribe/ und gehe
anschließend auf “How Much is Membership”. Hier kannst Du
Dich als Premium Member anmelden, die Mitgliedsdauer und
die Zahlungsmethode (Kreditkarte oder PayPal) wählen. Mit
der Bezahlung bist Du Premium Mitglied und Du kannst GPX-
Dateien und Pocket Queries herunterladen.

DOWNLOAD VON GSAK

Rufe http://gsak.net/ auf und lade die neueste Version von GSAK auf Deinen Rechner
und sichere die Datei anschließend in ein separates Verzeichnis.

http://www.geocaching.com/subscribe/
http://gsak.net/
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Zum Testen ist GSAK kostenlos und man kann es für $ 20,- erwerben. Die Shareware-
Version beinhaltet die komplette GSAK-Version und ist voll funktionsfähig. Wenn man
GSAK 21 Tage lang ohne Registrierung benutzt hat, erhältst Du nach dem Start des
Programms einen „Hinweis“ und dieser wird mit jeder weiteren Nutzung länger auf dem
Bildschirm erscheinen. Wenn Dir das Programm zusagt, bitten wir um Registrierung
unter http://gsak.net/Register.php. Nach Eingabe des Reg-Keys (Serien-Nummer), wird
der Hinweis auf dem Bildschirm nicht mehr erscheinen. Registrierte Benutzer sind zur
Nutzung aller Updates und Ergänzungen des Programmes ohne zusätzliche Kosten
berechtigt.

INSTALLATION VON GSAK

Klicke auf die Start-Taste und dann auf “Ausführen” und suche im Verzeichnis, in dem
Du die heruntergeladenen Datei gespeichert hast nach “GSAKxxxx.exe“, (xxxx ist die
Versionsnummer). Nach einem Klick auf die Datei einfach „Open“ und dann „OK“
anklicken.

Nun behinnt die Installation von GSAK. Beim Erscheinen der Meldung “Open File
Security Warning Appears” einfach „Run” anklicken.

Es wird vorausgesetzt, dass Du einwilligst GSAK in das ausgewählte Verzeichnis zu
installieren. Nach dem Anklicken auf „Next“, „Accept“, „Next“ und „Install“ wird
GSAK auf dem Computer installiert.

DER ERSTE START VON GSAK

Du startest GSAK mit einem Doppelklick auf das Icon (eine rote Flagge mit
einem weißen Kreuz) auf dem Desktop.

Du wirst gefragt, ob Du GPX- und LOC-Dateien mit GSAK “Associate” [=verknüpfen]
willst. Dies bedeutet, dass jegliches Anklicken einer solchen Datei GSAK öffnet. Wenn
Du weitere Geocaching-Software auf Deinem Computer hast und trotzdem immer GSAK
nach einem Doppelklick auf GPX- und LOC-Dateien verwenden möchtest, musst Du
„Force Association Each Time GSAK starts” [=Verbindung mit GSAK bei jedem Start
bevorzugen] markieren. Dies verhindert, dass andere Software diese Verknüpfungen mit
benutzt.

Wenn Du möchtest, dass GSAK beim Doppelklick auf GPX- oder LOC-Files geöffnet
wird, musst Du “Associate” [=verknüpfen] anklicken. Wenn Du möchtest, dass andere
Programme geöffnet werden, musst Du „Cancel“ [=abbrechen] anklicken. Wichtig: Du
kannst diese Einstellungen in GSAK jederzeit ändern, indem Du im “Tools”
[=Werkzeuge]-Menue Veränderungen wie oben ausgeführt unter “GPX File
Association…” durchführst.

http://gsak.net/Register.php
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Als nächstes wird GSAK on Du die Beispiel-Daten auf Deine Datenbank hochladen
möchtest. Wenn Du sofort reale Daten hochladen möchtest, klicke auf „no“ [=nein],
wenn Du Dich zuerst mit den Beispieldaten beschäftigen willst, klicke bitte auf „yes“
[=ja].

Nun öffnet das “Getting Started” [=ins Laufen bringen]-Menue. Arbeite Dich durch
dieses Hilfe-Thema durch und klicke auf die Links um mit den Grundlagen des
Programms und seinen Hilfsordnern vertraut zu werden. Befürchte nicht, dass Du sofort
alles auswendig lernen musst – Du wirst Schritt für Schritt durch die Grundlagen des
Programms geführt.

DIE VERWENDUNG VON GSAK

Laden von Cache-Daten: Als erstes musst Du einige Cache-
Daten in das GSAK-Programm laden. Du kannst individuelle
Cache-Daten laden, oder kannst – wenn Du ein Premium
Member bist – Pocket Queries bei geocaching.com erstellen,
womit Du Informationen von bis zu 500 Caches per Email
zugestellt bekommst (dies wird weiter unten erklärt).

Von jetzt an wird vorausgesetzt, dass Du Premium Member bei Geocaching.com bist, da
Du so optimale Informationen für die Verwendung von Cache-Daten unter GSAK
erhältst.

Erstelle unter Windows einen Ordner in “My Documents” um hier Deine
herunztergeladenen Dateien speichern zu können. Nenne diesen Ordner z. B.
„Geocaches“.

Laden von individuellen Cache-Daten:  Um Daten für einen individuellen Cache
herunterladen zu können, musst Du bei Geocaching.com eingeloggt sein. Gehe auf die
Cache-Seite und klicke links oben (unter der Koordinaten- und Entfernungsangabe) bei
“Click Icon to Download” auf “GPS eXchange File (*.gpx)”.  Im Fenster
„Dateidownload“ auf „Speichern“ klicken um die Datei in dem zuvor erstellten Ordner
(siehe oben) z. B. „Geocaches“ abzulegen.
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Laden von Cache-Daten in das GSAK-Programm:  Klicke in GSAK-Menue auf
“File” [=Datei] und dann auf „Load GPX/LOC“ [=Lade GPX/LOC-Dateien] (ab hier
werden Menue-Befehle folgendermassen z. B. dargestellt: „File>Load GPX/LOC). Das
Fenster, welches sich nun öffnet fordert Dich auf die Art festzulegen, wie Du eigene
Caches behandeln möchtest. Dies ist ein wichtiger Schritt, damit GSAK Dich erkennt und
somit Deine eigenen und gefundenen Caches erkennen kann. Schreibe Deinen
Geocaching-Namen in das vorgesehene Feld (doppelt um sicher zu stellen, dass kein
Schreibfehler enthalten ist) und klicke auf „OK“. Diese Eingabe muss nicht wiederholt
werden, da die eingegebenen Daten gespeichert werden.

Nun öffnet der „Load….“-Dialog. Klicke auf das kleine Icon auf der rechten Seite und
wähle Deinen “Geocache”-Ordner. Klicke auf die Datei, die Du gerade heruntergeladen
hast, klicke auf „Open“ [=öffnen] und dann auf „OK“. GSAK lädt die Cache-
Informationen in seine Datenbank und die sich öffnende „Load Summary“  [=Übersicht
über heruntergeladene Dateien] zeigt Informationen über die eben geladene Datei. Klicke
auf „OK“.

Du wirst sehen,m dass der Cache nun in einer Reihe in der oberen Hälfte von GSAK
erscheint. Dies wird als „Grid View“ [=Rasteransicht] bezeichnet und jede Reihe enthält
Informationen über einen Cache.

Oberhalb der Rasteransicht erläutert eine Statuszeile: Subset [=ausgewählt]: None
[Keines]; 1 Shown (all waypoints) [=einer angezeigt (alle Wegpunkte)]; Center Point:
Greenwich Meridian [=Mittelpunkt: Nullmeridian]; Counts [=Zählung] (gefolgt von 4
verschieden farbigen Feldern).

Klicke auf die untere Ecke der Statusleiste und halte die Maustaste gedrückt um sie nach
oben ziehen zu können. Wenn dies nicht möglich ist, einfach die „F2“-Taste drücken
(was die Bildschirmansicht aufteilt), um so die Statuszeile aufwärts bis in die Mitte des
Bildschirms zu ziehen.

Nun siehst Du die Cache-Information im unteren Bereich des Bildschirmfensters. Dies
wird als „Split Screen View” [=geteilte Bildschirmansicht] bezeichnet.

Das vorgegebene Format ist “Voller Bildschirm”. Dies zeigt alle Cache-Informationen,
die in der GPX-Datei enthalten sind, so dass man nicht mehr zu Geocaching.com
wechseln muss. In der Mitte der Statusleiste, relativ weit oben, findest Du ein Icon „Split
Screen Format“ [=Bildschirmformat aufteilen]. Betrachte die unterschiedlichen
Möglichkeiten (Achtung: für diesen Schritt muss eine Internet-Verbindung hergestellt
sein!). Stelle das Bildschirmformat anschließend wieder auf „Full Display“ [=ganzer
Bildschirm] ein.
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Erstelle Deine Home-Koordinaten: Eine der Stärken von GSAK
ist die Möglichkeit, Caches in Bezug auf die Entfernung zu einer
vorgegebenen Örtlichkeit darzustellen. Wenn Du nicht auf dem
Nullmeridian in England wohnst (was sehr wenige tun!), musst Du
Deine „home location“ [=Wohnort] anlegen, die angibt, bei welchen

Koordinaten Du wohnst.

Als erstes mußt Du Deine Heimat-Koordinaten ermitteln. Wenn sie Dir nicht bekannt
sind, ermittle diese mit Deinem GPS und kopiere die Koordinaten folgendermaßen ins
GSAK:

Gehe zu Tools>Options und klicke auf das “Locations”- Aymbol. Klicke unterhalb
“#Somewhere else….” im Textfeld und schreibe Home, ein Komma und dann Deine
Heimatkoordinaten, wieder getrennt durch ein Komma. Beachte, dass die Koordinaten in
einer der Formen wie in den Beispielen gezeigt, eingegeben werden. Vergewissere Dich,
dass Du ein Komma zwischen Home, der Breiten- und der Längenkoordinate gesetzt
hast. Vergewissere Dich ebenfalls, dass die Breitengrad- vor Längengrad-Koordinate
gesetzt wurde. Vergewissere Dich ferner, dass die Koordinaten exakt stimmen,
einschließlich N oder S (nördlich oder südlich des Äquators) bzw. E oder West (östlich
oder westlich vom Nullmeridian).

Klicke auf “OK” um zur GSAK Rasteransicht zurückzukehren. Wähle das „Location“-
Menue der Symbolleiste den Menuepunkt „Home“. In der Spalte „Kms“ wird nun die
Entfernung des Caches zu Deinen Home-Koordinaten dargestellt. Wenn Du eine
Darstellung in Meilen bevorzugst, wechsle zu Tools>Options, dann zum Registerkarte
„General“ und klicke hier rechts oben „Miles“ unter „Distance Calculation“
[=Entfernungsmessung] an. Klicke anschließend auf „OK“. Nun werden die
Entfernungen entsprechend in Meilen dargestellt.

Verarbeitung von Pocket Queries: Um den
größtmöglichen Vorteil von GSAK nutzen zu können,
möchtest Du möglichst viele Caches in die Datenbank laden
(beispielsweise alle Caches um Deinen Wohnort). Dies
macht man bevorzugt mit „Pocket Queries“ von
geocaching.com. Detaillierte Informationen erhält man hierzu
über:

http://members.aol.com/marklent60544/myhomepage/Geocaching/pq.htm

Oder, wenn Du es auf gut Glück versuchen willst:
http://www.geocaching.com/pocket/ und klicke hier auf “Create a New
Query” (die Vorausstezung ist auch hier, dass Du als Premium Member
angemeldet bist).

http://members.aol.com/marklent60544/myhomepage/Geocaching/pq.htm
http://www.geocaching.com/pocket/
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Egal wie Du es machst, wenn Du ein Pocket Query an geocaching.com gesendet hast,
wird Dir normalerweise innerhalb weniger Minuten eine Datei zugemailt. Schau nach
Deinen Emails!

Übertragen eines Pocket Queries nach GSAK:  Der Weg ist fast identisch mit der
Übertragung von von Einzelnen GPX-Dateien.

Sichere die Datei zuerst in Deinem “Geocaches”-Ordner (siehe oben).

Gehe als nächstes zu File>Load in GSAK und wechsle in den Geocache Ordner.

Klicke auf die gespeicherte Pocket Query Datei (beachte: GSAK kann komprimierte
Dateien selbstständig entpacken – dies muss vorher nicht gemacht werden). Klicke auf
„Open“. Dann auf „OK“. Die Caches des Pocket Queries (bis zu 500) werden nun in
GSAK geladen und eine Zusammenfassung erscheint in einem separaten Fenster. Mit
„OK“ wird dieses Fenster geschlossen.

Ansicht der Cache-Informationen: Jede der Reihen beinhaltet die Daten von einem
Cache. Wenn Du auf einen Cache klickst werden dessen Details in einem
Bildschirmausschnitt angezeigt.

Wenn Du den Cache auf einer Landkarte darstellen möchtest musst Du online sein.
Klicke dann mit der rechten Maustaste auf die Cache-Reihe in der Rasteransicht und
bewege Deinen Cursor nach unten bis zur „Custom URL“ [=gewünschte URL] und
wähle eine entsprechende Karte aus (teste “Google Satellite View” am Ende der Liste).

Sortierung:  Durch Klicken auf die Spitze einer jeden Spalte können die Informationen
sortiert werden. Wenn Du z.B. auf die „Code“-Spalte klickst werden die Caches nach
dem Geocaching-Code sortiert. Das gleiche gilt für die Kms und alle anderen Spalten.
Ein nochmaliger Klick kehrt die Sortierung um.

Caches auswählen:  Um einen Cache in GSAK auszuwählen, musst Du in der Spalte
unter dem  Icon auf die Reihe des Caches klicken. Dies wird durch ein Häkchen, der
„User Flag“ angezeigt. Diese Häkchen können für einzelne Caches oder mehrere Caches
gesetzt werden. Für mehrere Caches einfach mehrere Caches anklicken. Mehrere Caches
kann man auch aus dem „User Flag“-Menue oder mittels Kurzbefehl auswählen (das
Anklicken des „User Flag“-Menues zeigt Dir die Möglichkeiten.

Ein nützlicher Weg um eine größere Anzahl von Caches zu selektieren ist User
Flags>Select for next nn records. Was bedeutet „nn records“? Dies bedeutet die nächste
numerische (nn) Anzeige im GSAK Raster. Um dieses Merkmal nutzen zu können, musst
Du zunächst einen Cache anklicken. Wähle danach „User Flags> User Flags>Select for
next nn records”. Schreibe nun z. B. “10” in das sich öffnende Feld und klicke auf “OK”.
Daraufhin werden 10 Caches unterhalb des selektierten Caches mit einem Häkchen
markiert sein.
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Um die Selektion eines Caches zu löschen, genügt es, nochmals auf das Häckchen zu
klicken und die Markierung verschwindet. Um die Selektion mehrerer Caches rückgängig
zu machen wählt man User „Flags>Clear all user flags“ [=Häkchen>alle Häkchen
löschen]. Dies macht die komplette Selektion rückgängig.

Herausfiltern:  Das Herausfiltern ist eines der wichtigsten Bestandteile von GSAK.
Das Filtern erlaubt Dir, einen Anteil von Caches auszuwählen und zu anderen
hinzuzufügen. Du kannst löschen, verschieben, exportieren oder eine Gruppe von Caches
an Dein GPS senden.

Wähle zur Demonstration durch Anklicken auf der “User Flag”-Spalte einige Caches aus.
Betätige nun die F8-Taste. Beachte, dass im Raster nun ausschließlich solche Caches
angezeigt werden, die Du mit einem Häkchen ausgewählt hast. Wenn Du bereits andere
Caches ausgewählt hast, kannst Du diese hinzufügen. Gehe zu „User Flags>Clear all user
flags“ oder drücke die F7-Taste um die Häkchen zu löschen und wieder alle Caches
anzuzeigen.

Der GSAK-Filter kann wesentlich mehr. Um Deine Caches anderweitig zu filtern, musst
Du „Search>Filter“ wählen. Oder klicke auf die Filter-Taste der GSAK Symbolleiste, die
so aussieht:

.
Ein “Set Filter” [=Filter setzen] Fenster zeigt Dir die verschiedenen Möglichkeiten auf.
Mehrere Registerkarten zeigen Dir die verschiedenen Möglichkeiten, die Du zur
Selektion heranziehen kannst.

Ein einfacher Filter soll als Beispiel dienen. Du möchtest z. B. alle Traditionals in einem
Umkreis von 20 km um Deine Home-Koordinaten ermitteln. Klicke auf „Search>Filter“.
Auf der General-Registerkarte ist das 4. Kriterium von oben “Distance” [=Entfernung].
Wähle im “Any Distance” [=jede Entfernung]-Fenster „Less than or Equal To“
[=weniger oder gleich]. Tippe 20 in das rechte Fenster für die Entfernungsangabe.

Klicke nun auf die “Other” [=andere]-Registerkarte im “Set Filter”-Fenster und klicke
“Clear All” [alle löschen] unterhalb der Auflistung der Cache-Typen. Klicke danach im
Fenster links auf „Traditional“. Klicke nun auf „Go“ unten links im Filter-Fenster. GSAK
wechselt nun zur Rasteransicht in der nun ausschließlich Traditionals angezeigt werden,
die sich innerhalb einer Entfernung von 20 km um Deine Heimkoordinaten befinden.

Um den Filter zu löschen (und alle Deine gewählten Caches anzuzeigen), musst
Du nach “Search>Cancel Filter“ wechseln oder das rote X der Symbolleiste
anklicken.

Übertragung von Waypoints auf Dein GPSr: GSAK kann einen einzelnen Wegpunkt
oder eine „Reihe“ von Wegpunkten direkt zu Garmin- oder Magellan GPS-Empfängern
senden. Eine “Reihe“ entspricht den angezeigten Caches in der Rasteransicht. So können
gefilterte Cachereihen direkt an dem GPS-Empfänger übertragen werden.
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Wähle als erstes “GPS>Setup”. Wähle den Hersteller Deines GPS (Garmin oder
Magellan). Wenn Dein GPS über einen USB-Anschluß (nicht einen USB-Serial-
Konverter), musst Du die „GPSr is USB“-Karte anwählen. Bei Verwendung eines
seriellen Anschlusses wird hier kein Haken gesetzt sondern der COM Anschluss
angegeben, an dem Dein GPS mit dem Computer verbunden ist. Bei Magellan muss
zusätzlich die Verbindungsgeschwindigkeit angegeben werden (da alle Garmin-Geräte
gleich sind, muss dies bei jenen nicht angegeben werden). Zum Schluss muss die
maximale Anzahl der Wegpunkte – entsprechend dem Handbuch des Geräts – angegeben
werden, die verwaltet werden können. Bestätige anschließend mit „OK“.

Nachdem Du mittels Filter die Caches bzw. alle angezeigten Caches ausgewählt hast,
musst Du versichert sein, dass die maximale Anzahl von Wegpunkten nicht überschritten
ist. Die Menge wird an der Statuszeile unten angezeigt.

Verbinde Deinen GPS-Empfänger mit dem Computer und schalte ihn an. Wechsle nun zu
„GPS>Send Waypoints“ und klicke „Send“ an. Die ausgewählten Wegpunkte werden
nun übertragen.

Wenn Du weder ein Garmin- noch ein Magellan-Gerät hast? Oder wenn Du die
Wegpunkte an ein anderes Programm senden möchtest gibt Dir der nächste Punkt hierzu
eine Erläuterung.

Export:   Wähle nach den obigen Angaben Caches aus.

Gehe zur Datei File>Export und wähle das Exportformat aus (zur Abstimmung für
Deinen GPS-Empfänger oder die Software). Ein Dialogfenster erscheint für das
ausgewählte Exportformat. Wegen der Vielzahl der Exportformate kann hier nicht näher
darauf eingegangen werden. Bitte beachte hierzu das  “GSAK help file” für
weitergehende Informationen (“Help>Contents“ oder F1-Taste).

Wähle für Hinweise zur Benutzung der Hilfe-Funktionen die entsprechende Rubril im
GSAK-Forum: http://www.gsak.net/board/index.php?showtopic=955&st=0& - entry5743

Geniese GSAK!

Weitergehende Informationen erhältst Du bei GSAK 201 – Anpassung von GSAK, die
Du hier herunterladen kannst:
http://gsak.info/board/index.php?showtopic=2335&view=findpost&p=13777

http://www.gsak.net/board/index.php?showtopic=955&st=0&
http://gsak.info/board/index.php?showtopic=2335&view=findpost&p=13777

